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An APA running head is not 
needed for undergraduate or 

master’s courses per the 
University Writing and Style 

Guidelines. If you are a student 
in a doctoral program, or 

otherwise require a running 
head in your paper, consult 
the doctoral APA Sample 

Paper in the CWE>Tutorials 
and Guides>Doctoral Writing 

Resources. 

Pagination: Use the 
header feature in 

Microsoft® Word to set 
the page number (see 

Appendix A). 

 

The title: Use upper and lower case 
letters, centered between the left and 
right margins, and positioned on the 

upper half of the page. Use black, 12-
point Times New Roman font 

throughout. Arial and Courier font 
types are acceptable. 

 

All lines are double-spaced throughout 
the entire document. Use black, 12-point 
Times New Roman font throughout the 
document. Arial and Courier font types 

are acceptable. 

 

This APA Sample Paper is intended for undergraduate and master’s level students. 
 
The University of Phoenix APA sample papers represent the consensus of key academic officials within the University. This particular 
sample reflects expectations outlined in the University of Phoenix Writing and Style Guidelines for undergraduate and master’s courses, 
which correspond with the University’s preferred style guide for most programs: The Publication Manual of the American Psychological 
Association, Sixth Edition. If your course materials direct you to follow MLA style, please see the MLA Sample Paper in the Center for 
Writing Excellence (CWE)>Tutorials and Guides>MLA Information. 
 
This sample paper is offered as a concise tool to help students with style, but it is not a definitive or binding representation of format for 
all courses. The CWE provides many tools to help students write and format effective papers; however, the faculty member determines 
the assignment grade in the course. 
 

Abstract: Typically, an abstract is required only for 
publication. If your assignment instructions indicate 
a requirement to use an abstract, a sample can be 
found in the CWE>Tutorials and Guides.  
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Indent the 
first line of 

each 
paragraph 
using the 
tab key, 

set at five 
to seven 

spaces or 
one-half 

inch. 

Direct 
quotations 
require a 

page 
number or 
paragraph 
number. 

 

Writing Style and Mechanics 

 The Publication Manual of the American Psychological Association (APA) began as a 

journal article in 1929. The APA reported results from a meeting of scholars “to establish a 

simple set of procedures, or style rules, that would codify the many components of scientific 

writing to increase the ease of reading comprehension” (APA, 2010, p. xiii). Today, the 

Publication Manual is in its sixth edition and the APA style described in it is a widely 

recognized standard for scholarly or professional writing in the social sciences. Although the 

style guide is designed to prepare manuscripts for publication, many universities and health care 

journals have adopted its use as a guide to achieve uniformity and consistency (Cuddy, 2002). 

Writing in the style prescribed by the Publication Manual can be a daunting experience for 

students. As with any new skill, “practice makes perfect” (S. Proofreader, personal 

communication, June 28, 2004). Points of APA style most often used by undergraduate and 

graduate students are listed below. However, keep in mind that this sample paper is a guide and 

should not be considered as a replacement for the Publication Manual. 

Format Considerations 

 Some commonly used rules and formats from the sixth edition of the Publication Manual 

are listed below. Please note, however, that some assignments may require unique formatting, 

and you should consult your syllabus for clarification.  

Correct Margins  

 Margins are one inch on all sides. This rule is broken only to avoid placing a lone 

heading on the last line of the page or a single line of text on the top of the next page. 

Use the paper 
title above your 

introduction, 
centered not 

bolded. 

Personal 
communication 

citation: No 
need to include 
on the reference 

page. 

 

Use one 
or two 
spaces 
after a 

period at 
the end of 

a 
sentence, 

but be 
consistent 
with usage 
throughout 

the 
document.  

 

Level one heading: 
Centered, bolded, upper 
and lower case letters. 

. 

Level 
two 

heading: 
Left 

margin, 
bolded, 
upper 

and lower 
case 

letters. 
 

Margins should be 
one inch on all 

sides of the 
document. 

 

Writers 
should 

ensure that a 
line is not tab 

indented 
when 

centering a 
heading so 
as not to 

appear off 
center. 
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The place of publication in a reference should include city and state using two letter postal abbreviation for the state. If the 
location is outside of the U.S., use the city and country. Examples: New York, NY. London, England. 

 

Page Header 

 The page header contains the page number aligned with the right margin. The automatic 

header function in Microsoft® Word should be used to place the page numbers consecutively in 

the paper (see Appendix A). Arabic numerals (1, 2, 3, and so on) are used to number each page, 

beginning with 1 on the title page. 

Document Headings 

 Paragraph headings should be used in long documents to organize the essay, to break it 

up into readable portions, and to make it easy for readers to locate information. Using headings 

in a short document before every paragraph can make the writing appear choppy, and the paper 

may not flow smoothly from point to point. Use paragraph headings if your document is longer 

than three or four pages or if the assignment instructions require paragraph headings.   

Reference Page 

 Hanging indentation is used for the reference page. The proper format can be set in 

Microsoft® Word (see Appendix B). Creating the hanging indentation by using the tab key or 

space bar will not protect the formatting if changes are made to the reference page at a later time. 

The reference page is alphabetized by author or by title of the work when no author is listed, and 

each entry contains the date of publication in parentheses directly after the author’s name. The 

title, the place of publication, and the name of the publisher follow the date of publication for a 

book entry. The proliferation of electronic materials has prompted APA to create formats 

designed specifically for Internet and web-based written material. Visit the APA website at 

http://www.apastyle.org for additional information about formatting electronic references. You 

will also find frequently asked questions and helpful free tutorials about using APA style. 

http://www.apastyle.org/
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Citation 
with a 
page 

number: 
One space 
between 

the p. and 
the 

number. 
 

Only references that have been cited in the paper are listed on the reference page. 

Personal communications are cited in the text but do not appear on the reference page because 

the reader cannot retrieve them. Additional reference examples are available in the Reference 

and Citation Examples tutorial in the Center for Writing Excellence (CWE) at Tutorials and 

Guides.   

In-Text Citations 

 Direct quotations. Direct quotations must mirror the original source word for word, even 

if errors are contained in the original text. To alert the reader that errors are part of the original 

material, the word [sic], enclosed in brackets and italicized, must follow the erroneous material. 

The source of the quotation must be cited. The format of direct quotations may vary with the 

placement of the quoted material in the sentence. The following is an example of how you may 

use a direct quotation from a website with an author: “Diversity is emerging as one of the most 

serious issues in the workplace today, yet most employers are not prepared to deal with it” 

(Copeland, 2003, Erroneous Assumptions, para. 1). The author’s last name, the year of 

publication, the website title or section title, and the paragraph number, when no page number is 

available, are included in the citation.  

The following is an example of how one may use a direct quotation from a book with one 

author: Venes (2001) stated, “The types of influenza doctors must prepare for fall into three 

categories” (p. 106). If the author’s name is stated prior to the quotation, include the date of 

publication (in parentheses) after the author’s name, and follow the quotation with the page or 

paragraph number. For a work with two authors, use both authors’ last names for every citation. 

If the source has three or more authors but fewer than six authors, list all authors in the first 

citation, and use the first author’s last name and the words et al. (without italics) for the rest of 

Level 
three 

heading: 
Indented, 
bolded, 

capitalize 
only the 

first 
word, 

period at 
the end, 
continue 

text 
same 
line. 

 

Level 
three 

heading 
usually 

only 
necessary 
in longer 
papers, 

most 
commonly 
in master’s 

and 
doctoral 
papers. 

 

“Erroneous 
Assumptions” 
is the heading 
of a section 
within the 

web-based 
article, 

“Managing a 
Multicultural 
Workforce.” 
Using the 

heading of a 
section for an 
online article 
citation will 
help your 

reader quickly 
locate the 

content in the 
original 
source. 
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the citations. If the source has more than six authors, you may use the first author’s last name and 

the words et al. (without italics) for every citation (APA, 2010, p. 175). The following example 

from the Publication Manual (2010, p. 42) shows a citation from a work with more than six 

authors using the first author:  (Good et al., 2001). Refer to the Reference and Citation Examples 

tutorial in the CWE at Tutorials and Guides for more examples of in-text citations. 

Quotations that contain fewer than 40 words are enclosed in double quotation marks 

within the text. Use single quotation marks for quotations contained within a direct quotation. 

Quotations of 40 words or more are indented in a block format without quotation marks. Use 

double quotation marks to indicate a quotation within the block quotation. The block quotation is 

started on a new line, and it is indented five to seven spaces or one-half inch. A sample block 

quotation appears on page 7 of this document.  

 Paraphrased or summarized material. Paraphrasing or summarizing allows the writer 

to present someone else’s ideas or intellectual property and to supply proper credit to the original 

author or authors (Lawton, Cousineau, & Hillard, 2001). When an author is paraphrased or 

summarized, the source must be cited in the text. If a source is mentioned more than once in a 

paragraph, a citation must be included each time. Page or paragraph numbers are not required for 

paraphrased material, but the Publication Manual recommends that writers include a page or 

paragraph number to help the reader easily locate the information (APA, 2010, p. 171). If a 

writer were to paraphrase information from an article located in an online database, the writer 

would format the citation as follows: Daniels (2004) included Darden Restaurants on her list of 

the 50 best companies for minorities. Here is an example where the author is not mentioned 

within the text: A list of companies has been singled out as best for minority employees (Daniels, 

2004). Both examples include the author’s last name and the date of publication. If the author’s 

Write out 
and with 
authors’ 
names 

mentioned 
within the 
text. Use 

an 
ampersand 
(&) when 
they are 
written 
within a 
citation. 
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name is not provided with the paraphrased text, it must be included in the citation. Refer to the 

Reference and Citation Examples in the CWE at Tutorials and Guides for examples of citing 

paraphrased material. 

Deciding to summarize, to paraphrase, or to provide a direct quotation is an important 

question one must consider when using sources in an academic paper. Summarizing and 

paraphrasing both consist of sharing a source author’s ideas by phrasing them in one’s own 

words. A writer should summarize or paraphrase source material when it is important to capture 

the basic idea but when the author’s exact words are not essential to the paper. Conversely, a 

writer should quote directly when the source verbiage is crucial and stating it any other way 

would cause it to lose its meaning. Usually writers will quote authors who are experts in their 

field and whose ideas support their own. However, excessive use of direct quotations should be 

avoided. Writers are encouraged to paraphrase when doing so will not change the meaning or the 

impact of a source (Ede, 2011). 

 Plagiarism. Plagiarism constitutes a serious academic concern. According to Lawton, 

Cousineau, and Hillard (2001), “Academic communities demand that writers credit others for 

their work and that the source of their material clearly be acknowledged” (para. 6). Internet 

access has resulted in an increase in plagiarism. McCabe noted (as cited in Sterngold, 2004), 

41% of students said they engaged in cut-and-paste plagiarism from online sources. The 

sentences and phrases used in one’s paper must be original or cited and referenced accordingly. 

Although it may be easier for a writer to use someone else’s words, doing so discredits the 

writer. When in doubt, cite. See the Plagiarism Guide in the CWE at Tutorials and Guides for 

more information about avoiding plagiarism and about properly citing intellectual property. 

 

Secondary 
Sources: 

Also called an 
indirect 

source. List 
only primary 

source in 
reference list, 

and cite 
secondary 

source author 
only within the 

text.  
Secondary 
sources are 
not ideal in 
academic 
writing and 
should be 
avoided.  

 

Electronic 
source and 
quotation:  

If the 
electronic 

source does 
not have 

page 
numbers, 
use the 

abbreviation 
para. for the 
paragraph 
number. 

Headings should not appear at the end of a page. For the sake of readability, move the 
heading to the top of the next page (see Other Format Issues on page 7). This ensures 

that the intended content of the following body text is clear.  
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Other Format Issues 

 The preferred typeface for APA style is black, 12-point Times New Roman (APA, 2010). 

However, Arial and Courier font types are acceptable. Avoid using any software settings that 

reduce spacing between words or letters or that add spacing between paragraphs. Use double-

spacing throughout the document. You may use one space or two spaces after sentence-ending 

punctuation in the body of your essay, but use consistent spacing at the end of a sentence 

throughout your essay.  

 Although the Publication Manual (2010) requires an abstract to precede the text, an 

abstract is not used in most student papers. Some assignments may require an abstract if students 

are submitting lengthy papers or project proposals. In those cases, the direction to submit an 

abstract will be in the assignment guidelines. A sample abstract can be found in the CWE at 

Tutorials and Guides.  

Writing Mechanics 

 Correct grammar, punctuation, spelling, and sentence structure—in addition to 

formatting—are essential components of scholarly writing. Strunk (1918/1999) emphasized the 

importance of being succinct: 

Vigorous writing is concise. A sentence should contain no unnecessary words, a 

paragraph no unnecessary sentences, for the same reason that a drawing should have no 

unnecessary lines and a machine no unnecessary parts. This requires not that the writer 

make all his sentences short, or that he avoid all detail and treat his subjects only in 

outline, but that every word tell. (para. 1)  

Block 
quotation (40 

or more 
words): 

Indent to the 
tab margin 
and do not 

include 
quotation 

marks.  The 
in-text citation 
occurs outside 

of the 
punctuation 

that ends the 
sentence. 
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Grammar 

 In addition to the provision of a standardized format for scientific writing, the Publication 

Manual (2010) emphasizes the importance of proper grammar. Important basic grammar 

principles are listed below. For further information, refer to Step-by-Step Grammar Review in 

the CWE. The Step-by-Step Grammar Review provides individualized practice with grammar 

and punctuation.  

Subject and verb agreement. A singular noun requires a singular verb and a plural noun 

requires a plural verb (APA, 2010). Words that intervene between the noun and the verb do not 

change this basic rule.  

Noun and pronoun agreement. When writers use a singular noun, they must also use a 

singular pronoun. To avoid using awkward combined forms such as he/she or (s)he, writers may 

reword the sentence and use a plural noun and a plural pronoun to eliminate the problem of 

nouns and pronouns that do not agree. For example, the sentence “A student applying for a job 

must carefully proofread his/her application” may be reworded to read, “Students applying for 

jobs must carefully proofread their applications.” Use of plural forms also helps writers reduce 

bias, avoid stereotypes, and refrain from using both singular and plural in the same sentence or 

paragraph. 

Passive voice. Passive voice obscures the actor in this sentence: “The house was 

painted,” because it omits who applied the paint. In contrast, the same sentence written in active 

voice would be something such as this: “Our company painted the house.” The passive voice, 

which is a form of “be” (is, was, were, will be, have been, etc.) and a participle (painted, etc.), is 

useful when the actor's identity is not important to the sentence or context. Overuse of the 

passive voice causes the document to read similarly to an instructional manual, dry and 
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monotonous. According to Sigel (2009), it weakens the essay’s argument and prevents clear and 

concise writing. Occasional use of the passive voice is acceptable, but documents written 

primarily in the active voice are more enjoyable and more persuasive to read (Sigel, 2009). 

Punctuation. Correct punctuation establishes the rhythm and readability of sentences. 

Use only one space after commas, colons, and semicolons. Use one or two spaces after a period 

at the end of a sentence (be consistent with use). When a hyphen or a dash is used, no space 

appears before or after the hyphen or dash (APA, 2010). In academic writing, use a comma to 

separate all words in a series of three or more, as in the following example: Tasks included 

reading, writing, and analyzing the information in the text. Correct use of commas and 

semicolons can be challenging for students. Writers should consider using a proofreading tool, 

such as WritePoint®, to aid in checking proper comma use.   

Capitalization. Capitalization is used to designate a proper noun or trade name as well as 

major words in titles and in headings. Instances where capitalization is not used include laws, 

theories, models, or hypotheses, such as ethical decision-making models and names of conditions 

or groups in an experiment, such as experimental or control groups (APA, 2010). A common 

error in capitalization is its use with the name of a job title or department. An example is human 

resources, which is not capitalized, versus the specific title of ACME Human Resources 

Department, which is capitalized.  

Seriation (elements written in a series). Items contained in a list help to clarify the 

point being made or help to clarify components of a subject. Bullets may be used for a list in 

academic writing according to APA standards (2010). To show seriation of separate paragraphs, 

however, number each paragraph with an Arabic numeral followed by a period that is not 
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enclosed in or followed by parentheses. To show seriation within a paragraph or a sentence, use 

lowercase letters in parentheses (see Appendix C).   

Numbers. Spell out numbers one through nine that appear in the body text. Use Arabic 

numerals to express numbers 10 and above. Exceptions to this rule are discussed in the Grammar 

and Writing Guides in the Center for Writing at Tutorials and Guides. Once in the Grammar and 

Writing Guides, go to Grammar Mechanics and select Number Usage for a list of the exceptions. 

If you have the Publication Manual, sixth edition (2010), refer to pages 111-114 for detailed 

information about number usage. 

Third person versus first person. Person refers to the point of view or the source of the 

writer’s opinions. Use third person (he, she, or they) in academic writing. When referring to 

yourself, however, stating “The writer instructed the patients” is ambiguous and may give the 

impression that you did not participate. Instead, use a first person personal pronoun: “I instructed 

the patients.” For the most part, reference to self in first person should be limited to personal 

reflection or opinion papers.  

Conclusion 

By understanding mechanics and usage requirements and by referencing materials 

appropriately with in-text citations and reference entries, you will clearly communicate the 

content of your work. Use the information included in this paper to develop effective academic 

papers. You are also encouraged to refer to the resources in the CWE and the style information 

from www.apastyle.org for additional information about academic writing.  

Always include a conclusion that summarizes 
the main points of the paper. 
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Reference Page: Use a separate page to list the 
references and double-space the entire page.  The word 

References is upper and lower case, centered, not 
bolded, at the top of the page.   

An 
online 
journal 
article. 

A book with 
a corporate 
author and 
an edition 
number. 

A source 
available on 
a university 
program or 
department 

website. 

A source 
with a 
digital 
object 

identifier 
(DOI). 

An 
electronic 

version of a 
republished 

book. 

A print 
version 

of a 
book. 

Italicize the 
titles of 

books and 
journals 

(including 
journal 
volume 

numbers). 
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Appendix A: Header Feature in Microsoft® Word 

Identify each page with the page number placed at the right margin. Do not use your 

name to identify each page. Be sure the font type and size are the same in the header as that used 

throughout the document. To create a correct header with an automatic page number in Word, 

use the following guidelines. 

Word 2010 and newer

1. Select the Insert tab.

2. Select the Header icon.

3. Choose the Blank header tab from the drop-down menu.

4. Tab to the right margin, and select the Page Number icon.

5. Place the cursor over Current Position. A drop-down menu should appear.

6. Select the Plain Number option. A number will appear at the right margin of your 

document.

7. Choose Close Header and Footer (the red X at the far right on the menu). Your 

cursor then appears at the beginning of the document, and automatic page numbers 

should be visible as you type each new page. 

Word 2003 

1. Select the View menu on the toolbar.

2. Select Header and Footer.

3. Place the cursor in the Header box and select the right justification button on the

toolbar so that the cursor in the Header box moves to the right.
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4. Use the automatic function for inserting the page number as illustrated in this picture by

selecting the first button with the # symbol.

5. Select Close. The header is complete.
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Appendix B: Creating a Hanging Indent in Microsoft® Word 

To create a hanging indent for your references page in Word, use the following guidelines. 

Word 2010 and newer

1. Select the text that requires a hanging indent or create a hanging indent at the top of the 

references page before typing the text.

2. From the Home menu, select the arrow in the Paragraph group seen below. This will 

bring up the Indents and Spacing tab.

3. Under Indentation, in the Special box, select on Hanging and select OK. 
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Word 2003 

1. Select the text that requires a hanging indent or create a hanging indent at the top of the 

references page before typing the text.

2. From the Format menu, select the Paragraph command.

3. In the Special list, under Indentation, select Hanging and select OK. 
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Appendix C: Seriation 

To show seriation (lists) within a paragraph or sentence, use lowercase letters, not 

italicized, in parentheses: 

Job satisfaction is increased when nurses are provided with (a) therapeutic massage, (b) 

relaxation therapy, and (c) music therapy. 

To show seriation of separate paragraphs, number each paragraph with an Arabic 

numeral, followed by a period but not enclosed in or followed by parentheses. A numbered list 

signifies that element 1 is more important than element 2 and so on. See the following examples 

to create a numbered or bulleted list. 

Berk (2001) suggests that parents determine suitability of books for children by using the 

following criteria: 

1. Books are made from durable material . . . [paragraph continues]

2. Books are action-oriented . . . [paragraph continues]

If all elements in the list are of equal importance, use bullets instead of numbers as shown below. 

Berk (2001) suggests that parents determine suitability of books for children by using the 

following criteria: 

 Books are made from durable material . . . [paragraph continues]

 Books are action-oriented . . . [paragraph continues]


